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1. Importante

1. Importante

Questa guida all'uso elettronica € intesa

per chiunque usi il monitor Philips. Leggere
accuratamente questo manuale d'uso prima di
usare il monitor. Contiene informazioni e note
importanti sul funzionamento del monitor.

La garanzia Philips € valida a condizione che

il prodotto sia usato in modo corretto, in
conformita alle sue istruzioni operative, dietro
presentazione della fattura o dello scontrino
originale, indicante la data d'acquisto, il nome
del rivenditore, il modello ed il numero di
produzione del prodotto.

1.1 Manutenzione e precauzioni di
sicurezza
O Awvisi

Lutilizzo di controlli, regolazioni o procedure
diverse da quelle specificate nelle presenti

istruzioni possono esporre al rischio di scariche

elettriche e pericoli elettrici e/o meccanici.

Leggere ed osservare le presenti istruzioni
durante il collegamento e I'utilizzo del monitor
del computer.

Funzionamento

e Tenere il monitor lontano dalla luce diretta
del sole, da luci molto luminose e da altre
fonti di calore. L'esposizione prolungata a
questo tipo di ambienti potrebbe causare
distorsioni nel colore e danni al monitor.

*  Rimuovere qualsiasi oggetto che potrebbe

cadere nei fori di ventilazione od ostacolare

il corretto raffreddamento delle parti
elettroniche del monitor.

¢ Non bloccare i fori di ventilazione sulle
coperture.

* Durante la collocazione del monitor
assicurarsi che il connettore e la presa
d'alimentazione siano facilmente accessibili.

* Se si spegne il monitor scollegando il cavo
dalimentazione o il cavo DC, attendere
6 secondi prima di ricollegare il cavo

dalimentazione o il cavo DC per il normale

funzionamento.

Utilizzare sempre il cavo d'alimentazione
approvato fomito da Philips. Se il cavo
dalimentazione ¢ assente, rivolgersi al
Centro Assistenza locale. (Fare riferimento
al Centro Informazioni Consumatori e
allAssistenza Clienti)

Non far subire al monitor forti vibrazioni o
impatti severi durante il funzionamento.

Non colpire né lasciare cadere il monitor
durante il funzionamento o il trasporto.

Manutenzione

Per proteggere il monitor da possibili danni,
non esercitare pressione eccessiva sul
pannello LCD. Quando si sposta il monitor,
afferrare la struttura per sollevarlo; non
sollevare il monitor mettendo le mani o le
dita sul pannello LCD.

Se si prevede di non utilizzare il monitor
per lunghi periodi, scollegarlo dalla presa di
corrente.

Scollegare il monitor dalla presa di corrente
se € necessario pulirlo con un panno
leggermente umido. Lo schermo puo essere
asciugato con un panno asciutto quando
I'alimentazione ¢ scollegata. Tuttavia, non
utilizzare solventi organici come alcool,
oppure liquidi a base di ammoniaca per
pulire il monitor.

Per evitare danni permanenti, non esporre
il monitor a polvere, pioggia, acqua o
eccessiva umidita.

Se il monitor si bagna, asciugarlo con un
panno asciutto.

Se sostanze estranee o acqua penetrano
nel monitor, disattivare immediatamente
I'alimentazione e scollegare il cavo
d'alimentazione. Quindi, rimuovere la
sostanza estranea oppure I'acqua ed inviare
immediatamente il monitor ad un Centro
Assistenza.

Non immagazzinare o usare il monitor LCD
in luoghi esposti a calore, luce diretta del
sole o freddo estremo.

Per conservare prestazioni ottimali del
monitor e utilizzarlo per un periodo
prolungato, utilizzare il dispositivo in un
luogo caratterizzato dalle seguenti condizioni
ambientali:
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* Temperatura: 0-40° C 32-95° F

* Umidita: 20-80% RH

IMPORTANTE: Attivare sempre uno
screen saver con animazione quando si
lascia il monitor inattivo. Attivare sempre
un'applicazione d'aggiornamento periodico
dello schermo se il monitor visualizzera
contenuti statici che non cambiano. La
visualizzazione ininterrotta di immagini
statiche per un lungo periodo di tempo pud
provocare sullo schermo il fenomeno di
"immagine residua” o "immagine fantasma",
noto anche come "burm-in".

[ "Burn-in", la "sovrimpressione" o "immagine
fantasma" € un fenomeno ben noto alla
tecnologia dei pannelli LCD. Nella maggior
parte dei casi il fenomeno "burn-in",
"immagine residua" o "immagine fantasma"
scompare gradatamente nel tempo dopo
che il monitor € stato spento.

0 Awiso

| casi piu gravi di "burmn-in" o "immagine residua"
o di “immagine fantasma’ non scompaiono e
non possono essere risolti. Tali danni non sono
coperti dalla garanzia.

Assistenza

La copertura del monitor deve essere
aperta esclusivamente da tecnici qualificati.

In caso di necessita di qualsiasi documento
per la riparazione o l'integrazione,
contattare il proprio Centro Assistenza
locale. (Fare riferimento al capitolo "Centri
Informazioni Consumatori")

Fare riferimento alla sezione "Specifiche
tecniche" per informazioni sul trasporto.
Non lasciare il monitor in un'automobile/
bagagliaio esposto alla luce diretta del sole.

& Nota

Consultare un tecnico dellassistenza se |l
monitor non funziona normalmente oppure se
non si € sicuri di come procedere dopo avere
seguito le istruzioni di questo manuale .

1.2 Awvisi e legenda

La sezione che segue fornisce una descrizione
di alcuni simboli convenzionalmente usati in
questo documento.

Note, Attenzione e Awvisi

In questa guida, ci sono blocchi di testo
accompagnati da icone specifiche che sono
stampati in grassetto o corsivo. Questi blocchi
contengono note, awvisi alla cautela ed
all'attenzione. Sono usati come segue:

e Nota

Questa icona indica informazioni e suggerimenti
importanti che aiutano a fare un uso migliore
del computer.

@ Attenzione

Questa icona indica informazioni che spiegano
come evitare la possibilita di danni al sistema o
la perdita di dati.

0 Awviso

Questa icona indica la possibilita di lesioni
personali e spiega come evitare il problema.

Alcuni awisi possono apparire in modo diverso
e potrebbero non essere accompagnati da
un'icona. In questi casi, la presentazione specifica
dell'awiso € prescritta dalla relativa autorita
competente.
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1.3 Smaltimento del prodotto e dei
materiali d’imballaggio

Apparecchi elettrici ed elettronici da smaltire
- WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers
Your display is manufactured with high quality

materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.
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2. Impostazione del monitor

2.1 Installazione

El Contenuti della confezione

%%art

PHILIPS

DVI (optional)

),

VGA (optional)

B Installazione della base

1.

2.

Collocare il monitor, a faccia in git, su una
superficie liscia, prestando attenzione a non
graffiare o danneggiare lo schermo.

Tenere la base del monitor con entrambe
le mani ed inserire con fermezza la base
nel supporto.

(1) Collegare delicatamente la base nel
supporto finché il fermo non blocca la
base.

(2) Usare le dita per serrare la vite situata
nella parte inferiore della base e fissare
saldamente la base al supporto.
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H Collegamento al PC
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Ingresso potenza AC
Ingresso VGA

© Ingresso DVI-D (disponibile per modelli

selezionati)

© Sistema antifurto Kensington

Collegamento al PC

1.

Collegare saldamente il cavo
d'alimentazione sul retro del monitor.

Spegnere il computer e staccare il cavo
d'alimentazione.

Collegare il cavo segnale del monitor al
connettore video sul retro del computer:

Collegare i cavi d'alimentazione del
computer e del monitor ad una presa di
corrente nelle vicinanze.

Accendere il computer ed il monitor. Se sul
monitor appare un'immagine, l'installazione
€ riuscita.

2.2 Funzionamento del monitor

~

El Descrizione del pannello frontale del

prodotto
190E3L:
(5]
/v ®/A /< /0K [0}
| I [\ | |
(7] (6] © ©6 0 o

190E3L (per modello 1A):

(5]
/v /A O/4 /0K [0)
| I [\ | |
(7] (6] o O (2] o
@ O |Accendere e spegnere il monitor.
© & /0K|Accedere al menu OSD.
Per tornare al livello precedente
o < del menu OSD.
o o |Cambiare il formato del display.
©-  |Regolare il livello di luminosita.
© A V [Regolare il menu OSD.
g
® Cambiare la sorgente del segnale
(6] di ingresso.
[l |Cambiare il formato del display.
Smartlmage Lite. Si possono
©@ @ |selezionare tre modalita:
Standard, Internet e Game (Gioco).




2. Impostazione del monitor
Bl Descrizione del menu OSD

Che cos’¢ il menu OSD (On-Screen Display)?

['menu OSD (On-Screen Display) € una
funzione di tutti i monitor LCD Philips.
Consente all'utente di regolare le prestazioni
dello schermo o di selezionare le funzioni del
monitor direttamente tramite una finestra

di istruzioni a video. Di seguito & mostrata
un'illustrazione della semplice interfaccia OSD:

190E3L:

Istruzioni semplici e di base sui tasti di
controllo

Nel menu OSD mostrato in precedenza,
premere i tasti ¥ A sul pannello frontale del
monitor per spostare il cursore e premere il

tasto OK per confermare la scelta o la modifica.

— Color

— Language

— OSD Settings

— Setup

Il menu OSD

Di seguito c'é una descrizione generale della
struttura del menu OSD. Questa puo essere
utilizzata come riferimento quando in seguito si
lavorera sulle diverse regolazioni.

Main menu

— Input I:

— Picture

Sub menu

VGA

DVI (available for selected model)

Picture Format
Brightness
Contrast

SmartContrast

Color Temperature
sRGB

User Define

— Wide Screen, 4:3
— 0~100
— 0~100

— On, Off

— 6500K, 9300K

Red: 0~100
Green: 0~100

Blue: 0~100

English , Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuii,

IR, Tirkge

Horizontal — 0~100

Vertical — 0~100
Transparency — Off,1,2,3,4

OSD Time Out — 55, 10s, 20s, 30s, 60s
Auto

Power LED — 0,1,2,3,4
H. Position — 0~100

V. Position — 0~100
Phase — 0~100
Clock — 0~100
Resolution Notification — On, Off
Reset — Yes, No
Information
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El Notifica di risoluzione

Questo monitor e progettato per rendere

le prestazioni ottimali alla sua risoluzione
originaria di 1440 x 900 @ 60 Hz. Quando il
monitor & impostato su una risoluzione diversa,
allaccensione ¢ visualizzato un awviso: Usare
1440 x 900 @ 60 Hz per ottenere i migliori
risultati.

La visualizzazione dell'avviso pud essere
disattivata dal menu Setup (Configurazione) del
menu OSD (On Screen Display).

B Funzioni fisiche

Inclinazione

2.3 Rimozione del supporto e della
base

El Rimozione della base

Prima di iniziare a smontare la base del monitor,
osservare le istruzioni che seguono per evitare
eventuali danni o lesioni.

1. Collocare il monitor; a faccia in gid, su una
superficie liscia, prestando attenzione a non
graffiare o danneggiare lo schermo.

2. Staccare la base dal supporto come segue:

(1) Usare le dita per allentare la vite situata
nella parte inferiore della base.

(2) Spostare delicatamente verso l'alto e |l
basso per rilasciare il fermo che blocca
la base e separare la base dal supporto.
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Bl Rimuovere la base

1. E possibile inserire un cacciavite a taglio nei
due fori di rilascio situati nel copricerniera
e sollevare delicatamente il copricerniera
per rimuoverlo.

2. Rimuovere le 4 viti e poi rimuovere la base
dal monitor.




3. Informazioni sul prodotto

3.1 Smartlmage Lite

El Che cos’é?

Smartimage Lite fornisce impostazioni
predefinite che ottimizzano lo schermo

per diversi tipi di contenuti, regolando
dinamicamente luminosita, contrasto, colore

e nitidezza in tempo reale. Che si lavori con
applicazioni di testo, che si visualizzino immagini
o che si guardi un video, Philips Smartimage Lite
fornisce prestazioni ottimizzate del monitor.

E1 Perché ne ho bisogno?

Poiché vuoi un monitor che forisce
visualizzazione ottimizzata di tutti i tipi di
contenuti, il software Smartlmage Lite regola
dinamicamente luminosita, contrasto, colore
e nitidezza in tempo reale per migliorare
I'esperienza visiva del monitor.

El Come funziona?

Smartlmage Lite € un’esclusiva tecnologia
all'avanguardia sviluppata da Philips per I'analisi
dei contenuti visualizzati su schermo. In base allo
scenario selezionato, Smartlmage Lite migliora
dinamicamente contrasto, saturazione del
colore e nitidezza delle immagini per migliorare
i contenuti visualizzati - tutto in tempo reale ed
alla pressione di un singolo tasto.

1 Come si abilita Smartimage Lite?

y

1. Premere ED per visualizzare il menu su
schermo Smartlmage Lite.

Tenere premuto & per passare tra
Standard, Internet e Game (Gioco).

I menu Smartlmage Lite restera sullo
schermo per 5 secondi; premere "OK" per
confermare.

Quando la funzione Smartimage Lite
abilitata, lo schema sRGB ¢é disabilitato
automaticamente. Per usare sRGB e
necessario disabilitare Smartimage Lite
usando il tasto ) che si trova sulla parte
frontale del monitor.

Oltre ad usare B i tasti per scorrere verso
il basso, si possono anche premere i tasti

V¥ A per eseguire le selezioni e premere
"OK" per confermare e chiudere il menu
Smartlmage.

Si possono selezionare tre modalita: Standard,
Internet, Game (Gioco).

@ SmartImage '™

Standard

Interne

Standard: Migliora il testo ed attenua la
luminosita per migliorare la leggibilita e
ridurre I'affaticamento degli occhi. Questa
modalita migliora significativamente la
leggibilita e la produttivita quando si lavora
con fogli di lavoro, file PDF, scansioni di
articoli o altre applicazioni generiche.
Internet: Questo profilo combina
saturazione del colore, miglioramento
dinamico di contrasto e luminosita per
visualizzare foto ed altre immagini con
notevole chiarezza e colori brillanti, tutto
senza modifiche o attenuazione dei colori.
Game (Gioco): Attiva il circuito overdrive
per ottenere tempi migliori di risposta,
riduce i lati deformati degli oggetti in rapido
movimento sullo schermo, migliora il
rapporto di contrasto per schemi luminosi
o scuri; questo profilo fornisce la migliore
esperienza di gioco per gli appassionati.
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3.2 SmartContrast

El Che cos’e?

Tecnologia unica che analizza dinamicamente

i contenuti visualizzati ed ottimizza
automaticamente il rapporto di contrasto del
LCD per la massima chiarezza e piacevolezza
visiva, aumentando l'illuminazione per
immagini pit chiare, luminose e nitide oppure
diminuendola per la visualizzazione di immagini
chiare su sfondi scuri.

E1 Perché ne ho bisogno?

Vuoi la chiarezza ed il comfort visivo migliore
per ogni tipo di contenuto. SmartContrast
controlla dinamicamente il contrasto e regola
lilluminazione per immagini e videogiochi chiari,
nitidi e luminosi, oppure per visualizzare testo

chiaro e leggibile per i lavori d'ufficio. Riducendo

il consumo energetico del monitor, si risparmia
sui costi e si allunga la durata del monitor.

El Come funziona?

Quando si attiva SmartContrast i contenuti
visualizzati saranno analizzati in tempo reale
per regolare i colori e controllare I'intensita
dell'lluminazione. Questa funzione migliora il
contrasto in modo dinamico per una grandiosa
esperienza d'intrattenimento quando si
guardano video o mentre si gioca.

3.3 Philips SmartControl Lite

I nuovo software SmartControl Lite Phillips
permette di controllare il monitor usando
una semplice interfaccia grafica. Le regolazioni
complicate appartengono al passato; questo
software facile da usare guida durante le
procedure per regolare con precisione la
calibratura del colore, Fase/Clock, punto di
bianco RGB, eccetera.

Dotato della tecnologia pit avanzata in materia
di algoritmi core per velocita d'elaborazione e

risposta, questo software compatibile Windows

7 dotato di attraenti icone animate € pronto
per migliorare la tua esperienza con i monitor
Philips!

El Installazione

Attenersi alle istruzioni e completare
linstallazione.

L'awvio si esegue ad installazione terminata.

Se si vuole avviare I'applicazione in un
secondo tempo, fare clic sul collegamento del
desktop o nella barra degli strumenti.

PHILIPS

et Meaitoe driver and software bsrallation

1 Lrgeagn o B e, Ui e, v, Sy, g it Crmee
1 Pk P g o P st

[ o e g i i s s i s o e

Procedura Wizard (guidata) primo avvio

La prima volta, dopo l'installazione di
SmartControl Lite, si passera automaticamente
alla procedura Wizard (guidata) primo awvio.
che guidera passo a passo nel corso delle
procedure di regolazione delle prestazioni del
monitor.
Per awviare la procedura guidata in un secondo
tempo, si puo andare al menu Plug-in.
Usando il pannello Standard si possono
regolare altre opzioni senza ausilio della
procedura guidata.

=] St e Tx

SmartControl Lite PHILIPS

Wizard
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E1 Inizio con il pannello Standard:

Menu Adjust (Regolazione):

* I menu Adjust (Regolazione) permette di
regolare: Brightness (Luminosita), Contrast
(Contrasto), Focus (Fuoco), Position
(Posizione) e Resolution (Risoluzione).

* Seguire le istruzioni ed eseguire la
regolazione.

* Lavoce Cancel (Annulla) chiede all'utente
se vuole annullare linstallazione.

SmartControl Lite PHILIPS
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SmartControl Lite PHILIPS
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Menu Color (Colore):

I'menu Color (Colore) permette di
regolare: RGB, Black Level (Livello di
nero), White Point (Punto bianco),
Color Calibration (Calibratura colore)
e Smartlmage Lite (fare riferimento alla
sezione Smartlmage Lite).

Seguire le istruzioni ed eseguire la
regolazione.

Fare riferimento alla tabella che segue per
informazioni dettagliate sulle voci dei menu
secondari in base all'ingresso.

Esempio di Color Calibration (Calibratura
colore).

(o] St L 1= i
SmartControl ¢ PHILIPS |
Black Level |
Foepery sdpoited Btk Lovel ol et 0 @ o o
Eatal P S rage Wi hack Lownl o
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SmartControl ¢ PHILIPS

White Point
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SmartControl '

2. Fross Show Ma 1o e oo 52 e the
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L Fraly, praw Start ta bage the callwation
srncem

’

-
5
=
2
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"Show Me" (Mostrami) awvia il Tutorial della
calibratura colore.

Start (Awvia) — Awia la sequenza di 6 fasi
della calibratura colore.

Quick View (Visione rapida) carica le
immagini prima/dopo.

Fare clic sul tasto Cancel (Annulla) per
tornare al pannello principale Color
(Colore).

Enable color calibration (Abilita

calibratura colore) - Per impostazione
predefinita questa opzione ¢ attivata. Se &
deselezionata, la calibratura colore non ha
luogo ed i tasti Awvia e Visione rapida sono
disabilitati.

La schermata della calibratura deve avere le
informazioni dei diritti esclusivi.

Prima schermata della calibratura colore:

Il tasto Previous (Precedente) e disabilitato
fino alla seconda schermata colore.

Il tasto Next (Avanti) va alla schermata
successiva (ci sono 6 schermate).



3. Informazioni sul prodottd

* |l tasto Avanti dell'ultima schermata porta
al pannello File>Presets pane (File >
Preselezioni).

* |l tasto Cancel (Annulla) chiude l'interfaccia

e torna alla schermata Plug-in.
Smartimage Lite
Permette di modificare le impostazioni
per ottimizzare la visualizzazione in base ai
contenuti.
Quando e impostata la voce Entertainment
(Intrattenimento), sono abilitati anche
SmartContrast e SmartResponse.

<] et e

7x
SmartControl Lite PHILIPS

is 13

Options > Preferences (Opzioni > Preferenze)

- Sara attivo solo quando si seleziona
Preferences (Preferenze) dal menu a discesa

Options (Opzioni). Sugli schermi non supportati,

con capacita DDC/CI, saranno disponibili solo
le schede Help (Guida) e Options (Opzioni).

SmartControl U*® PHILIPS

Preferences.

A p———. L

*  Visualizza le impostazioni correnti delle
preferenze.

* Una casella selezionata abilita la funzione.
La casella pud essere selezionata e
deselezionata.

* Lavoce Enable Context Menu (Abilita
menu contestuale) € selezionata (attivata)
per impostazione predefinita. Enable
Context Menu (Abilita menu contestuale)
visualizza le opzioni di SmartControl Lite
di Select Presets (Selezione predefiniti) e
Tune Display (Regola schermo) del menu
contestuale del desktop (clic tasto destro
del mouse). Disabled (Disabilitato) rimuove
SmartControl Lite dal menu contestuale.

* L'icona Enable Task Tray (Abilita area
di notifica) & selezionata (attivata) per
impostazione predefinita. Enable Context
Menu (Abilita menu contestuale) mostra il
menu dell'area di notifica di SmartControl
Lite. Facendo clic col tasto destro del
mouse sull'icona nell'area di notifica, e
visualizzato un menu di opzioni con le voci
Help (Guida), Technical Support (Supporto
tecnico), Check for Update (Controlla
aggiornamenti), About (Informazioni) ed
Exit (Esci). Quando la voce Enable task
tray menu (Abilita menu area di notifica)
¢ disabilitata, I'icona dell'area di notifica
visualizza solo EXIT (ESCI).

* Lavoce Run at Startup (Esegui all'avwio)

e selezionata (attivata) per impostazione
predefinita. Quando disabilitato,
SmartControl Lite non si aviera all’awio,
né sara nell'area di notifica. Il solo modo
per awiare SmartControl Lite € usare |l
collegamento sul desktop oppure il file

del programma. Tutte le impostazioni
configurate per essere eseguite all'avwio non
si caricheranno quando questa casella €
deselezionata (disabilitata).

* Enable transparency mode (Attivare
modalita di trasparenza) (Windows 7,
Vista, XP). L'impostazione predefinita € 0%
Opaque (0% Opaco).

Options > Input (Opzioni > Ingresso) — Sara
attivo solo quando si seleziona Input (Ingresso)
dal menu a discesa Options (Opzioni). Sugli
schermi non supportati, con capacita DDC/CI,
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saranno disponibili solo le schede Help (Guida)
e Options (Opzioni). Tutte le atre schede di
SmartControl Lite non sono disponibili.
s %)

SmartControl Lite PHILIPS
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*  Visualizzare il pannello di istruzioni Source
(Origine) e le impostazioni correnti
dell'origine dell'ingresso.

*  Su schermi con un solo ingresso, questo
pannello non sara visibile.

Options > Audio (Opzioni > Audio) — Sara

attivo solo quando si seleziona Audio dal menu

a discesa Options (Opzioni).

Sugli schermi non supportati, con capacita

DDC/CI, saranno disponibili solo le schede

Help (Guida) e Options (Opzioni).
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Help > User Manual (Guida > Manuale d’uso)
— Sara attivo solo quando si seleziona User
Manual (Manuale d'uso) dal menu a discesa
Help (Guida). Sugli schermi non supportati, con
capacita DDC/CI, saranno disponibili solo le
schede Help (Guida) e Options (Opzioni).
e x|

SmartControl Lite PHILIPS

User Manual

BE A |

Help > Version (Guida > Versione) - Sara
attivo solo quando si seleziona Version
(Versione) dal menu a discesa Help (Guida).
Sugli schermi non supportati, con capacita
DDC/CI, saranno disponibili solo le schede
Help (Guida) e Options (Opzioni).

(e - Tx

SmartControl Lite PHILIPS

;C )

Menu contestuale sensibile
I Context Sensitive Menu (menu contestuale
sensibile) ¢ abilitato per impostazione
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predefinita. Se la voce Enable Context Menu
(Abilita menu contestuale) ¢ stata selezionata
nel pannello Options > Preferences (Opzioni >
Preferenze), il menu sara visibile.

@ SmartControl
Select Preset L4
Tune Display

Il menu contestuale ha quattro voci:

¢ SmartControl Lite - Quando selezionato,
¢ visualizzata la schermata About
(Informazioni).

*  Select Preset (Selezione predefiniti) -
Fornisce un menu gerarchico di impostazioni
predefinite salvate per 'uso immediato.
Un segno di spunta mostra l'impostazione
predefinita correntemente selezionata. Dal
menu a discesa puod essere richiamata la
voce Valori predefiniti.

» Tune Display (Regola schermo) - Apre il
pannello di controllo di SmartControl Lite.

¢ Smartlmage Lite — Controllo delle
impostazioni correnti, Standard, Internet,
Game (Gioco).

Menu area di notifica abilitato

[ menu dell'area di notifica pud essere
visualizzato facendo clic col tasto destro del
mouse sull'icona SmartControl Lite nell'area
di notifica. Il clic col tasto sinistro del mouse
awviera l'applicazione.

Help

Technical Support
Check for Update
About

Exik

Larea di notifica ha cinque voci:

* Help (Guida) - Accesso al User Manual
(Manuale d'uso): Apre il file del User
Manual (Manuale d'uso) usando il browser
predefinito.

» Technical Support (Supporto tecnico) -
Visualizza la pagina del Supporto tecnico.

*  Check for Update (Controlla aggiornamenti)
- Porta alla pagina PDI Landing e verifica la
versione dell'utente con quella pit recente
disponibile.

*  About (Informazioni) - Visualizza
informazioni dettagliate di riferimento:
versione del prodotto, informazioni sulla
pubblicazione e nome del prodotto.

*  Exit (Esci) - Chiude SmartControl Lite

Per eseguire di nuovo SmartControl Lite
selezionare SmartControl Lite dal menu
Programmi, fare doppio clic sullicona del

desktop, oppure riavviare il sistema.

PHILIPS

SmartControl

2010 MWD
Powered by Display Tune(R)

All Rights Reserved

Copyright of Suppliers Acknowledged

Menu area di notifica disabilitato

Quando l'area di notifica € disabilitata nella
cartella delle preferenze, € disponibile solo la
selezione EXIT (ESCI). Per rimuovere in modo
completo SmartControl Lite dall'area di notifica,
disabilitare la voce Run at Startup (Esegui
all'avvio) in Options (Opzioni) > Preferences
(Preferenze).
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4. Specifiche tecniche

Tipo di pannello LCD LCD TFT

[lluminazione LED

Dimensioni del pannello 19" L (48,26cm)

Rapporto proporzioni 16:10

Dimensioni pixel 0,2835 x 0,2835 mm

Luminosita 250 cd/m?

SmartContrast 20.000.000:1

Rapporto di contrasto (tip.) 100011

Tempo di risposta (tip.) 5ms

Risoluzione ottimale 1440 x 900 a 60Hz

Angolo di visuale 170° (H) / 160° (V) a C/R>10

Miglioramento dell'immagine Smartlmage Lite

Colori dello schermo 16,7 milioni

Frequenza d'aggiornamento 56Hz - 76Hz

verticale

Frequenza orizzontale 30kHz - 83kHz

sRGB Sl

Ingresso segnale DVI (digitale), VGA (analogico)

Segnale d'ingresso Sincronia separata, Sync on Green

Fungioni util 190E3L: /v ©/A @/4 /0K [0)

190E3L(1A): ED/v /A 0/ B/0K 0}
. Inglese, Francese, Tedesco, Italiano, Russo, Spagnolo, Cinese

Lingue OSD Segmpliﬁcato, Portoghese, Turco -

Altre funzioni utili Sistema antifurto Kensington

Compatibilita Plug & Play DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Inclinazione -5/+20

Acceso 17,77W (tip.), 18,98W (max.)

T Tensione ingresso | Tensione ingresso AC| Tensione ingresso AC

lisiedo & varien TS 50) AC a 100VAC +/-  |a 115VAC +/-5VAC, | a 230VAC +/-5VAC,
5VAC, 50Hz +/-3Hz | 60Hz +/-3Hz 50Hz +/-3Hz

Funzionamento normale (tip.) 14,5W 14,4W 14,37W

Sospensione 0,5W 0,5W 0,5W

Spento 0,5W 0,5W 0,5W
Tensione ingresso | Tensione ingresso AC| Tensione ingresso AC

Dissipazione di calore® AC a 100VAC +/- |a 115VAC +/-5VAC, | a 230VAC +/-5VAC,
5VAC, 50Hz +/-3Hz | 60Hz +/-3Hz 50Hz +/-3Hz

16
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Funzionamento normale 49,49 BTU/ora 49,15 BTU/ora 49,04 BTU/ora
Sospensione 1,71 BTU/ora 1,71 BTU/ora 1,71 BTU/ora
Spento 1,71 BTU/ora 1,71 BTU/ora 1,71 BTU/ora
. o , Modalita accensione: Bianco, Standby/Sospensione: Bianco
Indicatore di alimentazione :
(lampeggiante)
Alimentazione Integrato, 100-240VAC, 50-60Hz

Prodotto con base (LxHxP) 463,59 x 390,93 x 199,8 mm

Prodotto senza base (LxHxP) 463,59 x 320,46 x 41,1 mm

Prodotto con base 3,1%g
Prodotto senza base 2,8kg
Prodotto con la confezione 4,45kg

Portata temperatura (operativa) |Da 0° Ca40° C
Portata temperatura (non

Da -20° Ca 60° C

operativa)
Umidita relativa 20% a 80%

o Operativa: + 12.000 ft (3.658 m)
Altitudine Non operativa: + 40.000 ft (12192 m)
MTBF 30.000 ore
ROHS Sl
EPEAT Silver (www.epeat.net)

Confezione 100% riciclabile

Approvazioni a norma di legge Marchio CE, Classe B FCC, GOST, SEMKO, certificato TCO,
i 8° | UL/cUL, BSMI, 1509241-307
Colore Nero (parte posteriore), blu (parte anteriore)
Finitura [licido

@ Nota

1. La certificazione EPEAT Gold o Silver ¢ valida solo dove Philips registra il prodotto. Visitare il sito
www.epeat.net per conoscere lo stati della registrazione nel proprio paese.

2. Questi dati sono soggetti a cambiamenti senza preavviso. Andare all'indirizzo www.philips.com/
support per scaricare la versione piu recente del foglio informativo.
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4.1 Risoluzione e Modalita
predefinite

H Risoluzione massima
1440 x 900 a 60 Hz (ingresso analogico)
1440 x 900 a 60 Hz (ingresso digitale)

E1 Risoluzione raccomandata
1440 x 900 a 60 Hz (ingresso digitale)

480i 720 x 480 SD |60
480p 720 x 480 SD (60
5761 |720 x 576 SD |50
576p [720x 576 SD |50
720p |1280 x 720 HD |50, 60
10801 1920 x 1080 | HD |50, 60
1080p 1920 %1080 | HD |50, 60

6 Nota

Notare che lo schermo funziona meglio alla
risoluzione originale di 1440 x 900 a 60Hz.
Attenersi a questa raccomandazione per
ottenere la qualita migliore di visualizzazione.

18



5. Risparmio energetico

5. Risparmio energetico

Se la scheda video o il software installato sul

PC & conforme agli standard DPM VESA, |l
monitor puo ridurre automaticamente il suo
consumo energetico quando non & in uso.
Quando ¢ rilevato I'input dalla tastiera, dal
mouse o altri dispositivi, il monitor si "risveglia”
automaticamente. La tabella che segue mostra il
consumo energetico e le segnalazioni di questa
funzione automatica di risparmio energetico:

Modalita Si ia |Si i
o Video \‘ncroma \ncljoma Potenza usata | Colore del LED
VESA orizzontale | verticale
Attiva ATTIVO Si S [<1777 W (tip) Bianco
.
Sospensione [DISATTIVO| ~ No No | <05W (ip) ance
(lampeggiante)
Spegnimento|DISATTIVO - - <0,5W (tip.) DISATTIVO

La configurazione che segue € usata per

misurare il consumo energetico di questo

monitor.

* Risoluzione originale: 1440 x 900

»  Contrasto: 50%

*  Luminosita: 250 nit

* Temperatura colore: 6500k con modello
tutto bianco

e Nota

Questi dati sono soggetti a cambiamenti senza
preawiso.
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6. Informazioni legali

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
T caries the TCO Certified label,

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

» Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

*  Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

I[n Technology for you and the planet
CERTIFIED
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EPEAT
(www.epeat.net)
Q “The EPEAT (Electronic
QQ Product Environmental
7 &

Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on

571 environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

21

CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

» EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

»  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

»  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

+  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

»  2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

»  2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on I1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

¢ MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

* TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.
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Energy Star Declaration

(www.energystar.gov)

H As an ENERGY STAR® Partner, we

have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

€& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.

22

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de I'article
15 Des regles de la FCC. Ces limites sont
congues de fagon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
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Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This davice belongs to catagory B devices as described in EN 55022, unless it is spacifi-
cally stated that it is a Class A devics on the speciication labal. The following apglies to
devicss in Class 4 of EN 55022 (radius of protection up to 30 metars). The user of the
device is obliged to take all staps necessary 10 remove sources of interfarence 1o tale-
communication or othar devicss,

Pokud neni na typovém Etitku podtase uvedeno, 5o spadé do do tiidy A podia EN 56022,
spada automaticky do thidy B podie EN 55022, Pro zafizeni zefazend do tfidy A (chranné
péamo 30m) podle EN 55022 platl nésledujicl Dojde-li k rulanl talekomunikatnich nebo
finjch zafizeni je utivatal povinnen provést takovd opatfgnl, aby neeni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiege Centrum Badan | Certyfikacji

Urzdzende p»umm s by zasibane # priaads 2 preybgceonye obwodem ochronnym (grizdo 2
k! i dlpracuiace 2 soba urzsdzenia (komputer, monitor, drukarka) powinmy byé ssilane

2 tegn samego Arbdla.

ostalacjin bekirycons pomsitacaeni powiniss ziuiensd prazwadsic Bzowym rencowowa achrang
proed wwarciami, w postaci herpsecrnika o wartobel mamionavwej nie wickszej ni 16A (amperisw)
W el catkowitepo wylsesenia urzadzents 2 sieet zasilania, nalesy wyjaé wivczks kabla
ansilajgeego @ prinedka, kuire pewinno anajdowad sig w pobliz umJermxlnr Eatwa dosigpne.
Zaak bespiecatsiw “B” potwiendea podnosé uresdieia 2 wynsganiami bespiecaeisive
whytkowaiia zawatyinl w PN-ULT-A2107 § PN-ROE-DR251.

Pozostale instrukeje bespieczenstwa

* Nie emley wiywad wiyesek sdapterowyeh lub usuwad kelka abwodu achronnega 2 wiyeaki.
el homsecime jest utycie prodiuzaces o nalery wiyd preediuzaces S-zyloweg 2

b e przewodeen och
* System kamy v naleiy zaberpiceryé preed maghymi, i werustami bub spod-
kami napeecia, wEywajRe clieimars proaieE, urradlneni dogscrviysces b

berzakli

Naliiy upownié
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZEARERZIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schaden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Riickwand des Gerdtes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erfullt
sind.

Damit lhr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefuhrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

() ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

thEABEROHS

REPEAR (RFRS-SSREFHEEMNE (#FHATEKXREROHS) -
PANFEASIEH T AR A S SNE SR ENRNT RN BRI S B

FRERZR
B (RRRCRT)

ABRARYRATE
HiER AHARYRATH
& S b At SRBE | SR_EM
(Pb) | (Ho) | (Ca) | (CrE+) (PBB) (PBDE)
K o] [¢] ] @) [¢] [@)
CRTBRE x €] [¢] [e) [s] [e)
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7. Assistenza Clienti e
Garanzia

7.1 Ceriteri di valutazione dei pixel
difettosi dei monitor a schermo
piatto Philips

La Philips si impegna a consegnare prodotti della
pit alta qualita. Utilizziamo alcuni dei processi
di produzione piu avanzati nell'industria e delle
rigorose procedure di controllo della qualita.
Tuttavia i difetti dei pixel o dei pixel secondari
dei pannelli LCD TFT usati nei monitor a
schermo piatto a volte sono inevitabili. Nessun
produttore ¢ in grado di garantire che tutti

i pannelli siano privi di difetti dei pixel, ma la
Philips garantisce che qualsiasi monitor con un
numero inaccettabile di difetti sara riparato
oppure sostituito sotto garanzia. Questa nota
spiega i diversi tipi di difetti dei pixel e definisce
i livelli accettabili di difetto per ogni tipo. Per
avere diritto alla riparazione o sostituzione

in garanzia, il numero di pixel difettosi di un
pannello LCD TFT deve eccedere questi

livelli accettabili. Ad esempio: non piu dello
0,0004% dei pixel secondari di un monitor puo
essere difettoso. Inoltre, Philips stabilisce degli
standard di qualita ancora piu alti per alcuni
tipi o combinazioni di difetti dei pixel che sono
pit evidenti di altri. Questi criteri di valutazione
sono validi in tutto il mondo.

secondari secondari secondari

A A 4
pixel

Pixel e pixel secondari

Un pixel, o elemento dell'immagine, € composto
di tre pixel secondari nei tre colori primari
rosso, verde e blu. Molti pixel messi insieme
formano un'immagine. Quando tutti i pixel
secondari di un pixel sono illuminati, i tre pixel
secondari colorati appaiono insieme come un
singolo pixel bianco. Quando sono tutti spenti,
i tre pixel secondari colorati appaiono insieme
come un pixel nero. Altre combinazioni di pixel
illuminati o spenti appaiono come singoli pixel
di altri colori.

Tipi di difetti dei pixel

| difetti dei pixel e dei pixel secondari appaiono
sullo schermo in modi diversi. Esistono due
categorie di difetti dei pixel e diversi tipi di
difetti dei pixel secondari all'interno di ogni
categoria.

Punti luminosi

Questi difetti appaiono come pixel o pixel
secondari che sono sempre accesi oppure
‘attivi'. Un punto luminoso € un pixel secondario
che risalta sullo schermo quando il monitor
visualizza un motivo scuro. Ci sono vari tipi di

punti luminosi:

Un pixel secondario rosso, verde o blu
illuminato.

I C

Due pixel secondari adiacenti illuminati:
- Rosso + Blu = Viola
- Rosso + Verde = Giallo

- Verde + Blu = Ciano (blu chiaro)

Tre pixel secondari adiacenti illuminati (un pixel
bianco).
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€& Nota

Un punto luminoso rosso o blu deve essere
oltre il 50 percento pit luminoso dei punti
adiacenti mentre un punto luminoso verde ¢ |l
30 percento pit luminoso dei punti adiacenti.

Punti neri

Compaiono come pixel o pixel secondari
sempre spenti o 'inattivi'. Un punto nero ¢
un pixel secondario che risalta sullo schermo
quando il monitor visualizza un motivo chiaro.
Ci sono vari tipi di punti neri:

Prossimita dei difetti dei pixel

Poiché i difetti dei pixel e dei pixel secondari
dello stesso tipo che si trovano vicini fra loro
sono piu evidenti, la Philips specifica anche le
tolleranze per la prossimita dei difetti dei pixel.

Tolleranze dei difetti dei pixel

Per avere diritto alla riparazione o sostituzione
in garanzia a causa di pixel difettosi, un pannello
LCD TFT di un monitor a schermo piatto
Philips deve avere una quantita di pixel o pixel
secondari difettosi che eccede le tolleranze
elencate nelle tabelle che seguono.

PUNTI LUMINOSI LIVELLO ACCETTABILE
1 pixel secondario acceso 3

2 pixel secondari adiacenti accesi 1

3 pixel secondari adiacenti accesi (un pixel bianco) 0

Distanza tra due punti luminosi* >15mm

Totale di punti bianchi di tutti i tipi 3

PUNTI NERI LIVELLO ACCETTABILE
1 pixel secondario scuri 5 0 meno

2 pixel secondari scuri adiacenti 2 0 meno

3 pixel secondari scuri adiacenti 0

Distanza tra due punti neri* >15mm

Totale di punti neri di tutti i tipi 5 0 meno

TOTALE PUNTI DIFETTOSI

Totale di punti bianchi o punti neri di tutti i tipi

LIVELLO ACCETTABILE
5 o meno

& Nota

1. 1 o 2 pixel secondari adiacenti = 1 punto difettoso

2. Questo monitor e conforme ISO 9241-307. (ISO 9241-307: Requisiti ergonomici, metodi d'analisi
e di verifica della conformita per i dispositivi elettronici di visualizzazione)
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7.2 Assistenza Clienti e Garanzia

Per informazioni sulla copertura della garanzia e sui requisiti aggiuntivi di assistenza validi per la vostra
area, visitare il sito web www.philips.com/support. E inoltre possibile contattare il numero del vostro
Philips Customer Care Center piu vicino elencato in basso.

Informazioni di contatto per zona del’lEUROPA OCCIDENTALE:

» A »

Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Informazioni di contatto per zona del’lEUROPA ORIENTALE E CENTRALE:

A

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
IE’Iec::itir%egro NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
st NA Comel +380 562320045
NA Topaz-Service Company | +38 044 245 73 31
E— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 12426331
NA Profi Service +36 1 814 8080

Informazioni di contatto per zona dellAMERICA LATINA:

Paese Call center
Brazil

- Vermont
Argentina

Numero assistenza clienti
0800-7254101

0800 3330 856

Informazioni di contatto per la Cina:

Cina

Numero Assistenza clienti: 4008 800 008

Informazioni di contatto per il NORD AMERICA:

USA.

TOS

A

Teleplan

(877) 835-1838

Canada

Supercom

Supercom

(800) 479-6696
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Informazioni di contatto per l'area APMEA:

A

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
Ind : NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
feonesia Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA fé's Computer System Co. | 405 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
. . +84 8 38248007 Ho Chi Minh City
Vietnam NA FCPT Se“"c‘it'd”fo”mt'c +84 5113562666 Danang City
ST +84 5113.562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 10 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Banoladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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8. Risoluzione dei problemi e FAQ

8. Risoluzione dei problemi
e FAQ

8.1 Risoluzione dei problemi

Questa pagina tratta i problemi che possono
essere corretti dall'utente. Se il problema
persiste, dopo avere tentato queste soluzioni,
mettersi in contatto con I'Assistenza Clienti
Philips.

El Problemi comuni

Nessuna immagine (il LED d’alimentazione
non & acceso)

* Assicurarsi che il cavo d'alimentazione sia
collegato ad una presa di corrente ed alla
presa sul retro del monitor.

* Per prima cosa, accertarsi che il tasto
d'alimentazione sul pannello frontale
del monitor sia in posizione di OFF
(spegnimento), poi premerlo per metterlo
in posizione ON (d'accensione).

Nessuna immagine (il LED d’alimentazione &

bianco)

* Assicurarsi il computer sia acceso.

* Assicurarsi che il cavo segnale sia collegato
in modo appropriato al computer.

e Assicurarsi che il connettore del cavo del
monitor non abbia pin piegati. In caso
affermativo, sostituire il cavo.

e Potrebbe essere stata attivata la funzione di
risparmio energetico.

Lo schermo visualizza il messaggio

Attention

Check cable connection

e Assicurarsi che il cavo del monitor sia

collegato in modo appropriato al computer.

(Fare anche riferimento alla Guida Rapida)
* Assicurarsi che il connettore del cavo del
monitor non abbia pin piegati.
* Assicurarsi il computer sia acceso.
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Il tasto AUTO non funziona

* La funzione Auto ¢ applicabile solo in
modalita VGA analogico. Se il risultato non
¢ soddisfacente, si possono eseguire le
regolazioni manuali usando il menu OSD.

& Nota

La funzione Auto non e applicabile in modalita
DVI digitale perché non € necessaria.

Sono presenti segni visibili di fumo o scintille

*  Non eseguire alcuna delle procedure di
risoluzione dei problemi

*  Scollegare immediatamente il monitor dalla
presa di corrente per motivi di sicurezza

»  Chiamare immediatamente un
rappresentante del Centro Assistenza Philips.

E1 Problemi dell'immagine

Limmagine non & centrata

* Regolare la posizione dellimmagine usando
la funzione “Auto” dei controlli OSD.

* Regolare la posizione dell'immagine usando
la voce Phase/Clock (Fase/Clock) del menu
OSD Setup (Impostazione). E valido solo in
modalita VGA.

Limmagine vibra sullo schermo

»  Controllare che il cavo segnale sia collegato
in modo appropriato alla scheda video del
PC.

Appare uno sfarfallio verticale

* Regolare la posizione dellimmagine usando
la funzione “Auto” dei controlli OSD.

* Eliminare le barre orizzontali usando la
voce Phase/Clock (Fase/Clock) del menu
OSD Setup (Impostazione). E valido solo in
modalita VGA.

Appare uno sfarfallio orizzontale

* Regolare la posizione dellimmagine usando
la funzione “Auto” dei controlli OSD.
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* Eliminare le barre orizzontali usando la
voce Phase/Clock (Fase/Clock) del menu
OSD Setup (Impostazione). E valido solo in
modalita VGA.

Limmagine appare sfuocata, indistinta o troppo
scura

* Regolare il contrasto e la luminosita usando
il menu OSD.

Dopo avere spento il monitor, rimane una
"immagine residua", "immagine fantasma" o
"burn-in".

* Lavisualizzazione ininterrotta di immagini
statiche per un lungo periodo di tempo pud
provocare sullo schermo il fenomeno di
“immagine residua” o “immagine fantasma”,
noto anche come “burn-in". Il "Bum-in", la
"sovrimpressione" o "immagine fantasma"
¢ un fenomeno ben noto alla tecnologia
dei pannelli LCD. Nella maggior parte
dei casi il fenomeno "bum-in", "immagine
residua” o "immagine fantasma" scompare
gradatamente nel tempo dopo che |l
monitor ¢ stato spento.

* Attivare sempre uno screen saver con
animazione quando si lascia il monitor
inattivo.

* Attivare sempre un'applicazione
d'aggiornamento periodico dello schermo
se il monitor LCD visualizzera contenuti
statici che non cambiano.

e | casi pit gravi di "burn-in" o “immagine
residua” o di “immagine fantasma” non
SCOMPaiono e Non possono essere risolti.
Tali danni non sono coperti dalla garanzia.

L'immagine appare distorta. Il testo ¢ indistinto
o sfuocato.
* Impostare la risoluzione schermo del
PC sulla stessa risoluzione originale
raccomandata per il monitor.

Sullo schermo appaiono dei punti verdi, rossi,

blu, neri e bianchi

* | punti residui sono una caratteristica
normale dei cristalli liquidi usati dalla
tecnologia moderna. Fare riferimento alla
sezione Criteri di valutazione dei pixel
difettosi per altri dettagli.

La luce del LED "accensione" & troppo forte e
disturba
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* Laluce del LED d'accensione puo essere
regolata usando il menu OSD Setup
(Impostazione).

Per altra assistenza, fare riferimento all'elenco
Centri Informazioni Assistenza Clienti e
rivolgersi ad un rappresentante del Servizio
clienti Philips.

8.2 FAQ SmartControl Lite

Ho cambiato il monitor

da un PC ad uno diverso

e SmartControl Lite &
inutilizzabile, che cosa devo
fare?

Riavviare il PC e controllare

se SmartControl Lite funziona.
Diversamente, sara necessario
rimuovere ed installare di nuovo
SmartControl Lite per assicurarsi
che sia installato il driver
corretto.

Domanda 1.

Risposta:

Domanda 2. SmartControl Lite prima
funzionava bene, ma adesso
non funziona piu; che cosa devo
fare?

Se sono state eseguite le azioni

che seguono, potrebbe essere

necessario installare di nuovo il

driver del monitor.

* Lascheda video & stata cambiata

* |l driver video é stato aggiornato

* Attivita del sistema operativo, come Patch o
Service Pack

*  Aggiornamento automatico di Windows e
aggiornamento del driver monitor e/o video

*  Windows é stato awiato col monitor
spento o scollegato.

* Per capire, fare clic col tasto destro
del mouse su My Computer (Risorse
del computer) e fare clic su Properties
(Proprieta) -> Hardware -> Device
Manager (Gestione periferiche.)

*  Se si vede "Plug and Play Monitor" (Monitor
Plug and Play) sotto Monitor, & necessario
eseguire di nuovo linstallazione. Rimuovere
ed installare di nuovo SmartControl Lite.

Risposta:

Domanda 3. Dopo avere installato
SmartControl Lite, quando
faccio clic sulla scheda
SmartControl Lite non appare

nulla, oppure appare un
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messaggio d’errore; che cosa &

successo?
Probabilmente la scheda
video non & compatibile con

Risposta:

SmartControl Lite. Se la scheda

video & di una delle marche
dette in precedenza, provare a

scaricare il driver piu aggiornato
dal sito dell'azienda produttrice.
Installare il driver. Rimuovere ed
installare di nuovo SmartControl

Lite.

Se ancora non funziona,
siamo spiacenti di informare
che la scheda video non &

supportata.Visitare il sito Philips
e controllare se sono disponibili
driver aggiornati di SmartControl

Lite.

Domanda 4.
Information (Informazioni sul
prodotto) & mostrata solo
parte delle informazioni; che
cosa & successo!

La scheda video o il driver
potrebbe non essere della
versione piu recente che
supporta in modo completo
linterfaccia DDC/CI. Provare a

Risposta:

scaricare il driver piu aggiornato

della scheda video dal sito

dell'azienda produttrice. Installare

il driver.

Rimuovere ed installare di nuovo

SmartControl Lite.

Attention

Theft mode enabled

Mi sono dimenticato il mio
PIN per la funzione Theft
Deterrence (Antifurto). Che
cosa posso fare?

Il Centro Assistenza Philips

ha il diritto di chiedere
un'identificazione ed
un’'autorizzazione legittima per

Domanda 5.

Risposta:

stabilire la proprieta del monitor.
Notare che la funzione antifurto

¢ fornita come opzione utile
gratuita. La gestione dei PIN &

Quando faccio clic su Product
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I'unica responsabilita del singolo
utente o dell'organizzazione che
lo imposta.

Nel caso ci si dimentichi il PIN,

il Centro Assistenza Philips puo
reimpostarlo - per una tariffa
nominale - dopo avere verificato
la proprieta. Notare che questa
attivita non & coperta dai termini
di garanzia standard.

8.3 Domande generiche

Domanda 1:

Risposta:

Quando installo il mio monitor,
che cosa devo fare se lo
schermo visualizza il messaggio
"Cannot display this video
mode" (Impossibile visualizzare
questa modalita video)?
Risoluzione raccomandata per
questo monitor: 1440 x 900 a
60Hz.

Scollegare tutti i cavi, poi collegare il PC al
monitor usato in precedenza.

Aprire il menu Start di Windows e
selezionare Settings (Impostazioni)/Control
Panel (Panello di controllo). Nella finestra
del Control Panel (Pannello di controllo)
selezionare l'icona Schermo. Nella finestra
Display Control Panel (Pannello di controllo
- Schermo), selezionare la scheda 'Settings'
(Impostazioni). Nella scheda Impostazioni,
nell'area denominata “desktop area”
(Risoluzione dello schermo), spostare |l
dispositivo di scorrimento su 1440 x 900
pixel.

Aprire le "Advanced Properties" (Proprieta
Avanzate) ed impostare la Frequenza di
aggiornamento su 60Hz, poi fare clic su OK.
Riawviare il computer e ripetere le istruzioni
dei punti 2 e 3 per verificare che il PC sia
impostato su 1440 x 900 a 60Hz.
Spegnere il computer; scollegare il vecchio
monitor e ricollegare il monitor LCD Philips.
Accendere il monitor e poi accendere il PC.

Domanda 2: Qual ¢ la frequenza

Risposta:

d’aggiornamento raccomandata
per il monitor LCD?

La frequenza d'aggiornamento
raccomandata per i monitor
LCD e 60Hz. Nel caso ci siano
dei disturbi sullo schermo, la
frequenza d'aggiornamento puo



8. Risoluzione dei problemi e FAQ

Domanda 3:

Risposta:

Domanda 4:
Risposta:

Domanda 5:

Risposta:

Domanda 6:

Risposta:

Domanda 7:

Risposta:

essere regolata su un valore
massimo di 75Hz per cercare di
risolvere il problema.

Che cosa sono i file .inf e

.icm del CD-ROM? Come si
installano i driver (.inf e .icm)?
Questi sono i file driver del
monitor. Seguire le istruzioni
del Manuale d'uso per installare
i driver. La prima volta che si
installa il monitor, il computer
potrebbe richiedere i driver del
monitor (file .inf e .icm ) oppure
il disco del driver. Seguire le
istruzioni per inserire il (CD-
ROM in dotazione) fornito in
dotazione. | driver del monitor
(file .inf e .icm) saranno installati
automaticamente.

Come si regola la risoluzione?
La scheda video / il driver video
ed il monitor determinano
insieme le risoluzioni disponibili.
La risoluzione preferita si
seleziona nel Pannello di
controllo Windows® usando le
"Proprieta - Schermo".

Che cosa faccio se mi perdo
durante le procedure di
regolazione del monitor?
Premere il tasto OK e poi
selezionare "Reset" (Ripristina)
per richiamare tutte le
impostazioni predefinite.

Lo schermo LCD e resistente
ai graffi?

In generale si raccomanda di
non sottoporre la superficie
del pannello ad impatti e di
proteggerla da oggetti dalla
forma appuntita o arrotondata.
Quando si maneggia il monitor,
assicurarsi di non applicare
pressioni alla superficie del
pannello. Diversamente le
condizioni della garanzia
potrebbero essere modificate.

Come si pulisce la superficie
dello schermo LCD?

Usare un panno pulito, morbido
e asciutto per la pulizia normale.
Usare alcool isopropilico per
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una pulizia pit accurata. Non
usare altri solventi come alcool
etilico, etanolo, acetone, esano,

eccetera.

Domanda 8: Posso modificare |'impostazione
colore del monitor?

Risposta: Si, le impostazioni colore

possono essere modificate
usando, i comandi OSD, come
segue,

Premere "OK" per visualizzare il menu OSD
(On Screen Display)

Premere la "Down Arrow" (freccia giu)

per selezionare |'opzione "Color" (Colore)
e poi premere il tasto "OK" per accedere
alle impostazioni colore; ci sono tre
impostazioni, come segue.

1.

Color Temperature (Temperatura
colore); Le due impostazioni sono:
6500K e 9300K. Con la temperatura
colore 6500K il pannello appare caldo,
con toni rosso-bianchi, mentre con la

temperatura colore 9300K il pannello

appare freddo con toni blu-bianchi.
sRGB; € l'impostazione standard

per assicurare il corretto scambio di
colori tra i vari dispositivi (e.g. video/

fotocamere digitali, monitor, stampanti,

scanner, eccetera).

Personalizzato; si possono scegliere
le impostazioni preferite del colore
regolando rosso, verde e blu.

& Nota:

Una misurazione del colore della luce irradiato

da un oggetto mentre ¢ riscaldato. Questa
misurazione € espressa in termini di scala
assoluta (gradi Kelvin). Temperature Kelvin

basse, come 2004K; sono i rossi; temperature
pit alte - come 9300K - sono i blu. La

temperatura neutra € il bianco, a 6504K.

Domanda 9: Posso collegare il mio monitor
LCD a qualsiasi PC, postazione
di lavoro o Mac?

Risposta: Si. Tutti i monitor LCD Philips

sono compatibili con PC, Mac
e postazioni di lavoro standard.
Potrebbe essere necessario un
cavo adattatore per collegare

il monitor al sistema Mac.
Rivolgersi al rivenditore Philips
per altre informazioni.
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Domanda 10:

Risposta:

Domanda 11:

Risposta:

0 Awviso

| monitor LCD Philips sono
Plug-and-Play?

SI, i monitor sono compatibili
Plug-and-Play con Windows 7,
98, 2000, XP, Vista e Linux.

Che cos’e I'lmage Sticking,

o Image Burn-in, o
sovrimpressione, o immagine
fantasma dei pannelli LCD?

La visualizzazione ininterrotta di
immagini statiche per un lungo
periodo di tempo puo provocare
sullo schermo il fenomeno di
“immagine residua” o “immagine
fantasma”, noto anche come
“burn-in". Il "Burn-in", la
"sovrimpressione" o "immagine
fantasma" & un fenomeno

ben noto alla tecnologia dei
pannelli LCD. Nella maggior
parte dei casi il fenomeno
"burmn-in", "immagine residua" o
"immagine fantasma" scompare
gradatamente nel tempo dopo
che il monitor € stato spento.
Attivare sempre uno screen
saver con animazione quando si
lascia il monitor inattivo.
Attivare sempre un'applicazione
d'aggiornamento periodico dello
schermo se il monitor LCD
visualizzera contenuti statici che
non cambiano.

Fenomeni gravi di "bum-in", "immagine residua"
o "immagine fantasma" non spariranno e non
possono essere riparati. Tali danni non sono
coperti dalla garanzia.

Domanda 12:

Risposta:

Perché lo schermo non
visualizza il testo in modo
nitido e mostra dei caratteri
frastagliati?

Il monitor LCD funziona la
meglio con la sua risoluzione
originale di 1440 x 900 a 60Hz.
Usare questa risoluzione per
ottenere la visualizzazione
migliore.
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